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Formattazione

Testo e stile del contenuto
Una volta che il testo e le immagini sono stati raccolti in un unico file, usa 
Stili e Titoli per creare un aspetto coerente per i titoli di testo e sezioni. 
Utilizza le interruzioni di pagina invece del ritorno a capo o delle interruzioni 
di paragrafo per garantire la conservazione della formattazione durante 
la creazione del file PDF per la stampa. Applica regole di spaziatura 
personalizzate agli stili per mantenere un aspetto coerente in tutto il libro. L’ 
uso degli stili ti consente di modificare contemporaneamente tutto il testo 
assegnato a quello stile, anziché modificarlo riga per riga.

Opzioni di colore per il contenuto
La necessità della stampa a colori deve essere considerata nelle prime fasi 
del processo di formattazione. La tua opera contiene solo testo? In questo 
caso, puoi approfittare dei nostri prodotti bianco o crema, 60# bianco e 
nero non patinato standard per ridurre i costi di produzione. Per immagini 
ad alto contrasto e in scala di grigi, Lulu offre un bianco, 80# bianco e nero 
patinato standard. I nostri prodotti bianco, 60# colore standard non 
patinato permettono di incorporare elementi interessanti come caratteri 
colorati, evidenziazioni, grafici, grafiche, piccole foto o blocchi di colore 
a bassa pigmentazione/saturazione nel lavoro stampato, senza il costo 
premium.

Se desideri una stampa a colori della massima qualità, l’opzione Colori 
Premium offre la qualità necessaria per le foto ad alta risoluzione e la 
copertura delle pagine con margini al vivo. Disponibile su carta bianca, 
80# patinata e non patinata, ti consente di controllare il prezzo, offrendo 
comunque splendide immagini e colori vivaci.
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Risoluzione fotografica e grafica
I pixel per pollice (PPI) sono utilizzati per descrivere la densità di pixel di 
uno schermo (monitor del computer, smartphone, ecc.). I punti per pollice 
(DPI) si riferiscono alla risoluzione di stampa di un’immagine contando 
il numero di punti per pollice stampato. Maggiore è il numero di punti, 
migliore è la qualità della stampa (maggiori sono la nitidezza e il dettaglio). 
La maggior parte dei formati di file pronti per la stampa sanno come gestire 
la conversione tra PPI e DPI. I PDF ti consentono anche di avere file pronti 
per la stampa con valori PPI multipli, ma è opportuno considerare i risultati 
desiderati prima di inserire qualsiasi dimensione dell’immagine.

72 PPI è la risoluzione standard per la maggior parte degli schermi. Può 
essere adatta per le immagini digitali, ma il testo e i dettagli della grafica 
potrebbero finire per apparire distorti o sfocati nella stampa. Come regola 
generale, consigliamo un minimo di 150 PPI per la grafica semplice e di 300 
PPI per la grafica complessa o dettagliata.

Confronto della risoluzione dell’immagine

300 PPI 

Risoluzione ideale per 

grafiche complesse o 

dettagliate destinate alla 

stampa.

150 PPI

Risoluzione minima per la 

grafica semplice destinata 

alla stampa. 

72 PPI

La risoluzione standard 

per la maggior parte delle 

grafiche visualizzate nella 

versione digitale.
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Impostazione del colore del documento
RGB è un processo additivo, nel senso che aggiunge rosso, verde e blu 
insieme in quantità variabile per produrre altri colori, mentre CMYK è un 
processo sottrattivo che utilizza diverse quantità di ciano, magenta, giallo e 
nero per rimuovere i colori riflessi dalla carta al fine di creare altri colori che 
possiamo vedere. I due processi hanno diverse gamme di colore, con RGB 
che fornisce una più ampia varietà di possibilità; ecco perché viene utilizzato 
in dispositivi elettronici come i monitor dei computer. La stampa utilizza 
invece il CMYK. 

È risaputo che bisogna convertire i colori RGB in CMYK prima di mandare i 
file stampa. Si tratta in realtà di una vecchia pratica che può essere seguita 
senza problemi, ma i progressi compiuti nei flussi di lavoro di stampa non la 
rendono più necessaria.

Perché i modelli di Adobe InDesign sono configurati in RGB?

I moderni flussi di lavoro, come i processi adottati da Lulu, permettono 
alle stampanti di utilizzare profili di colore che abbinano automaticamente 
l’inchiostro CMYK ai valori RGB per produrre risultati simili. Seguendo queste 
poche e semplici linee guida, potrai ottenere il miglior colore possibile 
all’interno del libro: 

1.	 Se parti da zero, imposta il documento come file RGB.
2.	 Consigliamo di utilizzare lo spazio colore sRGB nel profilo colore 

del documento RGB e di applicare lo spazio colore sRGB a qualsiasi 
immagine RGB o link prima di creare il PDF per la stampa.

3.	 Se hai già creato o convertito il file in CMYK e convertito le immagini 
in CMYK, non è necessario passare di nuovo a RGB. La modifica delle 
impostazioni dello spazio colore dopo la finalizzazione del file può 
causare variazioni di colore indesiderate.

4.	 Il nero in tinta unita è composto da nero al 100%, senza colori aggiunti. 
Se aggiungi dei colori per arricchire il nero, il limite di copertura totale 
dell’inchiostro (TAC) non deve superare il 270%.

5.	 Evita di creare colori molto chiari, con una retinatura al di sotto del 20%. 
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Non è facile gestire in modo preciso le tonalità con retinatura inferiore 
al 20%.

6.	 Se stampi un libro a colori che contiene immagini in bianco e 
nero, l’impostazione del metodo del colore delle immagini deve 
corrispondere alla scala di grigi.

7.	 La gamma della scala di grigi dell’immagine deve essere compresa tra 
2,2 e 2,4. 

8.	 Utilizza solo foto ad alta risoluzione (300 DPI o superiore) e assicurati 
che siano coerenti con lo spazio colore del documento, a prescindere 
dall’utilizzo di RGB o CMYK.

9.	 Utilizza la stampa Colori Premium per l’Interno del libro e la carta 
Premium 80# quando stampi libri contenenti foto o grafica con una 
copertura di inchiostro importante e desideri un libro stampato vivace e 
ricco di colori. 

Profili spazio colore stampante Lulu:

RGB: sRGB IEC61966–2.1
CMYK: U.S. Web Coated (SWOP)



Copertina del libro

Contenuto del libro
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Anatomia di un libro
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Termini di formattazione

Dimensioni totali del documento

Le dimensioni totali del file con margine di pagina al vivo (bleed) incluso. 

Area del dorso

La larghezza del dorso varia in base al numero di pagine incluse nel libro. Usa 
la formula o la tabella appropriata per determinare la larghezza del dorso per 
i libri a copertina morbida e rigida. I libri con rilegatura a spirale e cucita non 
sono incollati al dorso, quindi non richiedono calcoli particolari.

Margine di sicurezza

Ti consigliamo di mantenere un bordo tra il margine di taglio e il contenuto 
importante (ad esempio, testo, immagini, numeri di pagina) per evitare che tali 
elementi vengano erroneamente ritagliati.

Area di lettura

L’ area della pagina per il testo, le immagini e altri contenuti.

Area pagina al vivo (bleed)

Durante la produzione, viene rifilato un bordo dalle pagine del libro stampato. 
Immagini, testo o altri elementi che dovrebbero andare oltre il bordo della 
pagina devono rientrare all’interno dell’area della pagina al vivo (bleed). Se un 
file viene caricato senza un margine al vivo, Lulu deve aggiungere un margine 
di 0,125 in (3,175 mm) su tutti i lati per una corretta rifilatura e rilegatura.  
Consulta la sezione “Dimensioni del file e margini di pagina al vivo” (pagina 11).

Area del codice a barre (opzionale)

L’area consigliata in cui è inserito l’ISBN. I libri non destinati alla Distribuzione 
Globale non richiedono un codice a barre o ISBN. Lulu non genera o inserisce 
per te il codice a barre o codice ISBN. 

Margine (a pagina 10)

Il margine interno delle pagine, che consente di piegare la pagina. Consulta la 

sezione “Aggiunte di margine per la rilegatura” (pagina 10).
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Area del margine di rilegatura

Aggiunte di margine di rilegatura
Si riferisce a uno spazio leggermente superiore sul lato di rilegatura 
delle pagine frontali riservata alla porzione di pagina inserita e incollata 
nella rilegatura del libro. I libri con rilegatura a spirale non richiedono un 
margine. Se il tuo libro ha più di 150 pagine, ti consigliamo di aggiungere un 
margine per la rilegatura. Se crei un libro tascabile o con copertina rigida, fai 
riferimento alla tabella delle aggiunte di margine di rilegatura:

Numero di 
pagine

Aggiungi a 
margine interno

Margine interno 
consigliato

Margine interno 
consigliato (al 

vivo)

Meno di 60 0" o 0 mm 0,5" o 13 mm 0,625" o 16 mm

Da 61 a 150 0,125" o 3 mm 0,625" o 16 mm 0,75" o 19 mm

Da 151 a 400 0,5" o 13 mm 1" o 25 mm 1,125" o 29 mm

Da 400 a 600 0,625" o 16 mm 1,125" o 29 mm 1,25" o 32 mm

Oltre 600 0,75" o 19 mm 1,25" o 32 mm 1,375" o 35 mm
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Dimensioni del file e margini di pagina al vivo
Nella realizzazione di un libro, i file vengono stampati e poi rifilati in base 
alle specifiche. Tutti i file dei libri vengono stampati con una dimensione 
maggiore di 0,125" (3,175 mm) su tutti i lati rispetto alla dimensione di 
taglio finale, in modo da tener conto del processo di rifilatura. Per gli accenti 
al bordo di pagine, sfondi e file, i risultati migliori sono dati dalla rifilatura della 
struttura della pagina.

Se il file formattato non include immagini che si estendono fino al bordo 
della pagina, puoi preparare il file con le dimensioni finali del libro e il nostro 
sistema aggiungerà automaticamente un bordo di taglio.

Se il file formattato include grafici, file o contenuti che si estendono fino al 
bordo della pagina, usa il grafico seguente per determinare le dimensioni 
ideali del file del contenuto.

Nota: se una pagina del contenuto prevede margini al vivo, tutte le pagine 
useranno le stesse dimensioni.

Quando utilizzare le dimensioni di margini di pagina al vivo 

Sì

È importante preparare il file 

di stampa con dimensioni 

dei margini di pagina al vivo 

per accenti e grafiche che 

si estendono fino al bordo 

della pagina.

Sì

Quando la grafica o il 

contenuto si estende 

oltre il bordo della pagina, 

è necessario utilizzare le 

dimensioni dei margini di 

pagina al vivo durante la 

preparazione del file. 

Non necessario

Se l’opera è composta 

principalmente da testo o 

ha margini bianchi distinti 

intorno al corpo, le dimensioni 

dei margini di pagina al vivo 

non sono necessarie.
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Nome del taglio
Dimensione del 

taglio

Dimensioni del 
file del contenuto: 

senza margini al vivo

Dimensioni del file 
del contenuto: con 

margini al vivo

Libro tascabile 4,25 x 6,875"
108 mm x 175 mm

4,25 x 6,875"
108 mm x 175 mm

4,5 x 7,125"
114 mm x 181 mm

Digest 5,5 x 8,5"
140 mm x 216 mm

5,5 x 8,5"
140 mm x 216 mm

5,75 x 8,75"
146 mm x 222 mm

A5 5,83 x 8,27"
148 mm x 210 mm

5,83 x 8,27"
148 mm x 210 mm

6,08 x 8,52"
154 mm x 216 mm

Regale 6,14 x 9,21"
156 mm x 234 mm

6,14 x 9,21"
156 mm x 234 mm

6,39 x 9,46"
162 mm x 240 mm

US Trade 6 x 9"
152 mm x 229 mm

6 x 9"
152 mm x 229 mm

6,25 x 9,25"
159 mm x 235 mm

Giornale a 
fumetti

6,63 x 10,25"
168 mm x 260 mm

6,63 x 10,25"
168 mm x 260 mm

6,88 x 10,5"
175 mm x 267 mm

Executive 7 x 10"
178 mm x 254 mm

7 x 10"
178 mm x 254 mm

7,25 x 10,25"
184 mm x 260 mm

Testo in quarti 7,44 x 9,68"
189 mm x 246 mm

7,44 x 9,68"
189 mm x 246 mm

7,69 x 9,93"
195 mm x 252 mm

Quadrato 
piccolo

7,5 x 7,5"
191 mm x 191 mm

7,5 x 7,5"
191 mm x 191 mm

7,75 x 7,75"
197 mm x 197 mm

A4 8,27 x 11,69"
210 mm x 297 mm

8,27 x 11,69"
210 mm x 297 mm

8,52 x 11,94"
216 mm x 303 mm

Quadrato 8,5 x 8,5"
216 mm x 216 mm

8,5 x 8,5"
216 mm x 216 mm

8,75 x 8,75"
222 mm x 222 mm

Lettera US 8,5 x 11"
216 mm x 279 mm

8,5 x 11"
216 mm x 279 mm

8,75 x 11,25"
222 mm x 286 mm

Orizzontale 
piccolo

9 x 7"
229 mm x 178 mm

9 x 7"
229 mm x 178 mm

9,25 x 7,25"
235 mm x 184 mm

Lettera US / 
Orizzontale

11 x 8,5"
279 mm x 216 mm

11 x 8,5"
279 mm x 216 mm

11,25 x 8,75"
235 mm x 184 mm

Orizzontale A4 11,69 x 8,27"
210 mm x 297 mm

11,69 x 8,27"
210 mm x 297 mm

11,94 x 8,52"
303 mm x 216 mm

Calendario 11 x 8,5"
279 mm x 216 mm

11 x 8,5"
279 mm x 216 mm

11,25 x 8,75"
286 mm x 222 mm
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Layout di copertina

Copertina generata da Lulu
Il nostro sistema inserisce le informazioni che ci fornisci per creare una 
copertina accattivante, completa di titolo, sottotitolo, collaboratore/i e 
descrizione. Si tratta di un’opzione ottima e veloce quando hai poco tempo a 
disposizione o hai semplicemente bisogno di alcune copie di prova.

Creazione e caricamento della tua copertina
Una volta che hai caricato il file del contenuto, generiamo un modello 
di copertina che puoi scaricare e che viene personalizzato secondo le 
specifiche del tuo libro. Creando la tua copertina, avrai il pieno controllo del 
contenuto.

Guida relativa alla larghezza del dorso
La larghezza del dorso della copertina è determinata dal tipo di libro da 
realizzare e dal numero di pagine totali. Le copertine morbide richiedono un 
minimo di 32 pagine di contenuto e la larghezza del dorso viene calcolata 
attraverso una formula. Le copertine rigide richiedono un minimo di 24 
pagine di contenuto e la larghezza del dorso si basa su una tabella con 
intervalli di pagine. 

Nota: una volta caricato il PDF del contenuto con le dimensioni del dorso 
incluse, Lulu fornisce un modello di copertina. 



CREAZIONE DEL FILE 14LULU GUIDA ALLA CREAZIONE DI UN LIBRO

Calcoli per la larghezza del dorso

Copertine morbide

Usa la formula per calcolare la dimensione della larghezza del 
dorso in pollici o millimetri.

Larghezza del dorso in pollici =  
(n° delle pagine interne / 444) + 0,06"

Larghezza del dorso in millimetri =  
(n° delle pagine interne / 17,48) + 1,524 mm

IM
PE

RI
AL

E
M

ET
RI

CO

Copertine rigide

Usa la tabella per determinare la dimensione della 
larghezza del dorso.

Numero di pagine
Larghezza del dorso 

(pollici)
Larghezza del dorso 

(mm)

0-23 N/D N/D

*24-84 0,25" 6 mm

85-140 0,5" 13 mm

141-168 0,625" 16 mm

169-194 0,688" 17 mm

195-222 0,75" 19 mm

223-250 0,813" 21 mm

251-278 0,875" 22 mm

279-306 0,938" 24 mm

307-334 1" 25 mm

335-360 1,063" 27 mm

361-388 1,125" 29 mm

389-416 1,188" 30 mm

417-444 1,25" 32 mm
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Numero di pagine
Larghezza del dorso 

(pollici)
Larghezza del dorso 

(mm)

445-472 1,313" 33 mm

473-500 1,375" 35 mm

501-528 1,438" 37 mm

529-556 1,5" 38 mm

557-582 1,563" 40 mm

583-610 1,625" 41 mm

611-638 1,688" 43 mm

639-666 1,75" 44 mm

667-694 1,813" 46 mm

695-722 1,875" 48 mm

723-750 1,938" 49 mm

751-778 2" 51 mm

779-799 2,063" 52 mm

800 2,125" 54 mm

Regolazione della larghezza del dorso
Lulu offre modelli in diversi formati che permettono la creazione di copertine 
nel software con cui hai maggiore dimistichezza. Di seguito è riportata 
una breve descrizione di come regolare la larghezza del dorso con Adobe 
InDesign o Adobe Photoshop. I modelli sono disponibili anche in formato 
PDF e PNG. Ogni modello del dorso del modello di copertina è preimpostata 
alla dimensione minima della larghezza. Tienilo presente quando modifichi il 
dorso.

Adobe InDesign

Utilizza il page toool per regolare la larghezza del dorso.

1.	 Individua Page Tool nel pannello degli strumenti e selezionalo. 
2.	 Nel pannello delle pagine, fai clic sulla pagina del dorso (pagina 2 del 

documento). La pagina sarà evidenziata nel pannello delle pagine. 
Specifica le seguenti impostazioni nel pannello di controllo Liquid 
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Layout (Window > Interactive > Liquid Layout):

	; Liquid Page Rule: Object-based

	; Object Constraints: Resize with Page: Width

3.	 Dopo aver determinato le dimensioni del dorso utilizzando la formula 
(copertina morbida) o la tabella di calcolo (copertina rigida) riportata 
in questo PDF, ridimensiona la pagina tramite i widget Height e Width 
nella barra di controllo. L’intera copertina dovrebbe aggiornarsi 
automaticamente ed essere quindi pronta per ospitare l’artwork.

Nota: il documento deve essere configurato con l’opzione pagine 
affiancate selezionata per il posizionamento automatico della copertina.

Adobe Photoshop

Regola le dimensioni dell’area di lavoro, verifica la larghezza del 
dorso e posiziona le guide per la copertina.

1.	 Sottrai la dimensione minima della larghezza del dorso esistente 
elencata sulla copertina dalla dimensione del dorso trovata utilizzando 
la formula (copertina morbida) o la tabella di calcolo (copertina rigida) 
riportata in questo PDF e aggiungi tale valore alla dimensione dell’area 
di lavoro. Vai a Image > Canva Size e inserisci la dimensione della 
larghezza complessiva rivista.

2.	 Utilizza lo strumento di selezione del percorso per selezionare il livello 
della forma del dorso nella cartella delle guide e inserisci la dimensione 
della larghezza corretta trovata usando la formula o la tabella di calcolo 
del dorso.

3.	 Allinea al centro la guida del dorso, a destra la guida della copertina 
e a sinistra la guida della quarta di copertina rispetto al documento. 
Assicurati che i livelli della guida siano posizionati correttamente e che 
non vi siano problemi.
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Progettazione del dorso 
La posizione del dorso può variare leggermente durante la produzione. 
Per consentire variazioni minime, invitiamo gli autori ad attenersi a queste 
linee guida durante la creazione della copertina, soprattutto nella fase di 
preparazione del dorso.

1.	 Non includere testo che vada a occupare l’intera larghezza del dorso. 
L’eventuale spostamento potrebbe far finire il testo del dorso nella 
copertina o nella quarta di copertina. Lascia almeno 0,125" (3,175 mm) 
tra il testo del dorso e il bordo su entrambi i lati del testo. 

2.	 Non includere testo su progetti con un numero di pagine uguale o 
inferiore a 80. Per i libri con poche pagine, il minimo spostamento 
del dorso farà finire il testo del dorso nella copertina o nella quarta di 
copertina.

3.	 Evita di usare immagini o colori solidi e di forte contrasto i cui bordi 
terminano in prossimità del dorso nella copertina o nella quarta di 
copertina. Mantieni il dorso del libro dello stesso colore e della stessa 
grafica del resto della copertina. 

4.	 Se il dorso avrà un colore diverso dal resto della copertina, progetta il 
tutto in modo da includere intenzionalmente la grafica o il colore del 
dorso nella copertina e nella quarta di copertina.

Rifilatura e varianza
Quando progetti il contenuto e la copertina, devi prendere in considerazione 
delle tolleranze. Durante la creazione del file, attieniti alle linee guida seguenti 
per assicurarti che il progetto venga stampato correttamente. La nostra 
tolleranza in termini di rifilatura è di 0,125" (3,175 mm) per la copertina e la 
quarta di copertina. Progettare il contenuto tenendo presenti variazioni e 
margini sufficienti ti aiuterà a evitare problemi con l’allineamento del testo del 
dorso e con eventuali porzioni di testo tagliate lungo i bordi del contenuto. 

Bordo di taglio

Si tratta del bordo del libro stampato e definitivo.
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(A5 a copertina morbida)

Bordo al vivo

Le immagini devono essere spinte verso il bordo al vivo, 0,125" (3,175 mm)   
oltre il bordo di taglio su ogni lato.

Bordo di sicurezza

Il testo e gli altri elementi importanti devono essere posizionati all’interno 
del bordo di sicurezza, che è pari a 0,125" (3,175 mm) all’interno del bordo 
di taglio. In questo modo, si garantisce che nessun testo venga tagliato a 
causa di variazioni nel processo di rifilatura.

Esempi di copertina sottoposta a variazione di taglio (pagine 19-21)

7101227817949
 

ISBN 978-1-79471-012-2
90000  

Quarta di copertina CopertinaDorso
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7101227817949
 

ISBN 978-1-79471-012-2
90000  

Corretto

L’immagine di sfondo è stata estesa di 0,125" (3,175 mm) oltre il bordo di 
taglio e sia il testo che le immagini importanti sono all’interno del bordo di 
sicurezza. 
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7101227817949
 

ISBN 978-1-79471-012-2
90000  

Errato

L’immagine di sfondo non è stata estesa verso il bordo al vivo. Ciò potrebbe 
provocare la visualizzazione di strisce bianche attorno ai bordi della copertina.

Risultato di formattazione errato
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ISBN 978-1-79471-012-2
90000  

Errato

Il testo della quarta di copertina e il testo del dorso non sono stati mantenuti 
all’interno del bordo di sicurezza. Ciò potrebbe comportare un’eliminazione 
di parte del testo a causa delle tolleranze durante la rifilatura. 

Risultato di formattazione errato



Invio del file

Preparazione del file

Correzione
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Preparazione del file
Quando carichi il file del contenuto nel sistema di Lulu, scansioniamo e 
analizziamo l’idoneità della tua opera per la stampa. In presenza di piccole 
imprecisioni, apporteremo alcuni piccoli cambiamenti. Talvolta il nostro 
sistema determina tuttavia la necessità di cambiamenti più importanti. In tal 
caso, ti avviseremo. Ti consigliamo caldamente di scaricare e controllare 
i tuoi file pronti per la stampa prima di completare il processo di 
pubblicazione.

Come utilizzare le opzioni Adobe PDF (job options) di 

Lulu

Quando si crea un PDF con i prodotti Adobe, utilizzare le 
opzioni di lavoro Adobe PDF di Lulu (Jib options). I file di opzione 
applicano impostazioni predefinite quando si esportano i PDF 
in base ai requisiti dei nostri centri stampa. I file delle opzioni 
(impostazioni di una pagina singola per l'interno e di una doppia 
pagina per la copertina) sono inclusi nei modelli di design Lulu 
nella nostra pagina dei prodotti.

I file di opzione PDF dovrebbero essere installati 
automaticamente quando si apre il file. In caso contrario, è 
possibile installarle manualmente:

Adobe InDesign

1.	 Andare a Selezionare File > Adobe PDF Presets > 
Definisci.

2.	 Cliccare su Carica e selezionare il file .joboptions.
3.	 Esporta il tuo file, seleziona le impostazioni di Lulu 

dall'elenco a discesa "Adobe PDF Preset" per esportare 
in formato PDF utilizzando le impostazioni delle Job 
Options.
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Adobe Photoshop

1.	 Vai a: Modifica > Adobe PDF Presets.
2.	 Fare clic su Carica e selezionare il file .joboptions.
3.	 Utilizzare "Salva come PDF di Photoshop" e selezionare 

le impostazioni .joboptions dal menu a discesa.

Adobe Acrobat Distiller

1.	 Vai a: Impostazioni > Aggiungi le impostazioni di Adobe 
PDF.

2.	 Navigare al file .joboptions e fare clic su OK.
3.	 Le nuove impostazioni saranno disponibili nell'elenco 

a discesa "Impostazioni predefinite". Assicuratevi di 
selezionarle prima di importare il file Postscript (.PS)

Specifiche per il file del contenuto
Quando crei il tuo libro con Lulu, devi fornire un PDF unico con tutti gli 
elementi del contenuto. Sono incluse la pagina del titolo e del copyright, oltre 
alle eventuali pagine vuote che desideri inserire. 

•	 Layout con orientamento verticale a pagina singola
•	 Le immagini incorporate devono avere una risoluzione compresa tra 300 

PPI (minima) e 600 
•	 PPI 
•	 Le immagini vettoriali devono essere rasterizzate 
•	 Tutti i caratteri devono essere correttamente incorporati
•	 I layer trasparenti e gli oggetti vettoriali devono essere appiattiti e 

uniformi
•	 Le pagine sono dimensionate in base alle dimensioni del libro: includi 

le dimensioni dei margini al vivo (0,125" oppure 3,175 mm) insieme alle 
dimensioni della pagina PDF:
Esempio: un libro di 6" x 9”richiede un PDF con pagine di dimensioni 
pari a 6,25" x 9,25" (158.75 x 234.95 mm) per rispettare i requisiti di 
stampa dei margini al vivo
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•	 Consenti un margine di sicurezza minimo di 0,50" (12.7 mm) per tutti i 
contenuti

•	 Consenti un minimo di 0,20" (5.08 mm) per il margine del bordo interno 
di tutte le pagine

•	 NON includere linee di taglio, indicatori di pagina al vivo o linee di margini
•	 Non proteggere il file tramite password/sistema di sicurezza

Specifiche del file della copertina
La copertina deve essere un PDF unico che include tutto il contenuto della 
copertina. Lulu fornirà un modello di copertina con le dimensioni esatte del 
dorso dopo che avrai caricato il PDF del contenuto. Ti consigliamo vivamente 
di utilizzare questo modello per garantire che il PDF della copertina venga 
stampato e ritagliato correttamente.

•	 Le immagini integrate hanno una risoluzione compresa tra 300 PPI 
(minima) e 600 PPI

•	 Le immagini vettoriali devono essere rasterizzate
•	 Tutti i caratteri devono essere correttamente incorporati
•	 I layer trasparenti e gli oggetti vettoriali devono essere appiattiti e 

uniformi
•	 Le pagine devono essere dimensionate in base alle dimensioni del libro 

previste: consulta pagina 13 per il  calcolo della larghezza del dorso
•	 Includi le dimensioni al vivo (0,125") (3,175 mm) nella dimensione delle 

tue pagine in PDF
•	 Consenti 0,25" (6.35 mm) come margine di sicurezza per tutti i contenuti 

(la copertina rigida rivestita richiede 0,75" (19.05 mm) come margine di 
sicurezza)

•	 NON includere linee di taglio, indicatori di pagina al vivo o linee di margini
•	 Non proteggere il file tramite password/sistema di sicurezza 
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Copertine di riviste e giornali a fumetti
Se vuoi creare una rivista o un giornale a fumetti, hai la possibilità di stampare 
anche sulla parte interna della copertina e della quarta di copertina. Questa 
modalità di stampa richiede un file della copertina a due pagine. Per ulteriori 
informazioni, consulta la sezione relativa al modello di copertina per riviste e 
giornali a fumetti.

Correzione
Forse una delle fasi più importanti (e spesso trascurata) del processo 
editoriale è l’approvazione della bozza finale. Ciò significa che avrai caricato, 
stampato e ricevuto una copia fisica del tuo lavoro come se fossi un 
comune lettore. La correzione del materiale stampato è fondamentale per 
la risoluzione dei problemi e l’identificazione degli errori. Alcuni problemi 
rilevabili durante la correzione includono:

Errore umano
A volte, quando si lavora con una scadenza, non si ha il tempo di rivedere 
completamente il file completato prima di inviarlo in stampa. Dopo aver 
ricevuto la copia di prova, potresti notare errori di battitura o problemi 
di formattazione. La soluzione migliore è quella di modificare il file del 
contenuto, ricaricarlo e ordinare una nuova copia di prova.

Errore del file
La bassa risoluzione dell’immagine, le trasparenze e i caratteri non 
incorporati sono problemi comuni che possono non risultare evidenti 
quando visualizzi il tuo manoscritto su uno schermo. Anche se il nostro 
sistema rileva e corregge molti di questi problemi, alcuni possono sfuggirci. 
Se nel libro stampato individui un errore non presente nella versione digitale 
del tuo file, contatta il supporto per ricevere assistenza.

https://help.lulu.com/it/support/tickets/new
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Variazione di stampa
Tutti i produttori cercano di realizzare prodotti precisi al 100%. Tuttavia, 
come per qualsiasi altro processo meccanico, esistono dei parametri di 
tolleranza da tenere in considerazione. La nostra tolleranza di rifinitura è 
paria a 0,125" (3,175 mm) per la copertina e la quarta di copertina. Progettare 
il contenuto tenendo presenti variazioni e margini sufficienti ti aiuterà a 
evitare problemi con l’allineamento del testo del dorso e con eventuali 
porzioni di testo tagliate lungo i bordi del contenuto.

Errore di produzione o spedizione
Il nostro obiettivo è stampare, rilegare e consegnare libri della massima 
qualità possibile; tuttavia, a causa della natura della produzione di libri su 
misura, non possiamo garantire la perfezione assoluta di ogni libro. Se il 
tuo libro risulta piegato, strappato, danneggiato o presenta altri difetti di 
produzione o di spedizione, contattaci all’indirizzo contatta il supporto per 
ricevere assistenza.

https://help.lulu.com/it/support/tickets/new
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